
CCA-101: Fundamentals of IT & Programming 

                          Assignment -1 

Q1: What are the four fundamental parts of computer? Explain it with the help 

of diagram. 

Ans:Four fundamental parts of compute are follow- 

 Central processing units(CPU) 

 Memory(ROM) 

 Input devices(keyboard,mouse) 

 Output devices(monitor,printer).                           

Q2: Discuss about the classification of computers based on size and capacity. 

Ans:Based on size and capacity, computers are classified as follows: 

 Super Computers 

 Mainframe Computer 

  Mini Computers 

  Micro Computers 

 Super Computers:Supercomputers are the most powerful and physically the 

largest by size. 

These are systems designed to process huge amounts of data and the 

fastest supercomputers. 

 Mainframe Computers: Mainframe computers are very large often filling an 

entire room and can process thousands of millions of instructions per 

second. 



 Mini Computers:These computers are  less expensive.      

Sometimes referred to as Midrange Server or Midrange Computer, they are 
typically larger, more powerful and more expensive than desktop 
computers.                                                                                       

 Microcomputers: Most frequently used type of computer. 

Also, known as Personal Computer (PC), a microcomputer is a small 

computer system designed to be used by one Person at a time. 

Q3: What is the meaning of computer generation? How many Computer 

Generations are Defined? What technologies were/are used? 

Ans:The evolution of digital computing is often divided into generations. Each 

generation is characterized by dramatic improvements over the previous 

generation in the technology used to build computers, in terms of the internal 

organization of computer and programming languages. 

5 computer generations were defined. 

Technologies used are- 

 Vacuum Tubes . 

 Transistors. 

 Integrated Circuits. 

 Microprocessors. 

 Artificial Intelligence. 

Q4: Differentiate between Volatile & Non- Volatile memories. 

Ans: 

Volatile memory  Non volatile memory 

They are the computer storage 
that only maintain its data 
while the device is powered. 

They are the computer memory that 
has the capacity to hold saved data 
even if power turned off. 

 

Q5: Distinguish among system software, application software and open source 

software on the basis of their feature. 

Ans:System Software: It is a type of software that is designed to run a computer's 

hardware and application programs. Software like operating systems, compilers, 



editors and drivers etc., come under this category. A computer cannot function 

without the presence of these.  

        Application software: It is software created for a specific purpose, used by 

end users. It can be called an application or simply an app. Examples: word 

processor, accounting application, a web browser, an email client, media player 

etc. 

        Open-source software: is a type of computer software in which source 

code is released under a license in which the copyright holder grants users the 

rights to study, change, and distribute the software to anyone and for any 

purpose. The Linux operating system(OS) is the best-known examples of open 

source software technology. 

Q6. A) Create a file in MS-word to insert a paragraph about yourself and save 

it with file name “yourself”. Describe all steps involved in it. 

Ans:Steps to make a files in MS word given below - 

I. Open the computer.  

II. Press the start  icon and go to all application. 

III. After that go to MS word a new window with a blank page appear.Move 

the mouse to the location where  want text in the document. 

IV. Left-click the mouse. The insertion point appears. 

V. Type the text about myself .Click the Microsoft Office button.  

VI. Select Save As Word Document. The Save As dialog box appears. Select the 

location where  want to save the document using the drop-down . 

VII. Enter a name for the document as yourself.   

VIII. Click the Save button.  

Q6 b) Write steps regarding followings 

 To change the font style  

 To change the font size  

 To change the font color 

 To highlight (in yellow) the line that reads “need to get IMS’s address” 

Ans: To format font style: 

o Select the text you want to modify.  

o Left-click the drop-down arrow next to the font style box on the Home 

tab. The font style drop-down menu appears.  



o Move your cursor over the various font styles. A live preview of the font 

will appear in the document. 

o Left click on the desired design. 

          To format font size: 

o Select the text you want to modify. 

o Left-click the drop-down arrow next to the font size box on the Home tab. 

The Font size drop-down menu appears. 

o Move your cursor over the various font sizes. A live preview of the font 

size will Appear in the document. 

o Left-click the font size you want to use. The font size will change in the 

document. 

           To format font color: 

o Select the text you want to modify.  

o Left-click the drop-down arrow next to the font color box on the Home 

tab. The Font color menu appears.  

o Move your cursor over the various font colors. A live preview of the color 

will appear in the document.  

o Left-click the font color you want to use. The font color will change in the 

document.  

To highlight a specific line: 

o Select the text “need to get IMS’s address”. 

o Left click the drop down arrow next to the highlight box. The highlight 

colours box appear. 

o Move the cursor over the yellow color. 

o Left click on it to highlight the desired line with yellow color. 

Q7. Create a file in MS-Word for the following document and save it with file 

name ‘ms_word’. Describe all steps involved in it. 



 

Ans:Steps to make a files in MS word given below - 

o Open the computer.  

o Press the start  icon and go to all application. 

o After that go to MS word a new window with a blank page 

appear.Move the mouse to the location where  want text in the 

document. 

o Left-click the mouse. The insertion point appears. 

o Type the text  .  

o Highlight , underline , bold , italic and cut some words as shown 

above.  

o Click the Microsoft Office button. 

o Select Save As Word Document. The Save As dialog box appears. 

Select the location where  want to save the document using the 

drop-down.  

o Enter a name for the document as ms_word.   

o Click the Save button.  

Q8. Create a file in MS-word for the following document and save it with file 

name ‘equations’. Describe all steps involved in it.                                        



   

Ans: 

o Open the computer. 

o Press the start  icon and go to all application.  

o After that go to MS word a new window with a blank page appear. Move 

the mouse to the location where  want text in the document.  

o Left-click the mouse. The insertion point appears. 

o  Type the text . 

o Use superscript and subscript from the home tab. 

o Click the Microsoft Office button. 

o Select Save As Word Document. The Save As dialog box appears. Select the 

location where  want to save the document using the drop-down.  

o Enter a name for the document as equations . 

o  Click the Save button.  

Q9. Create a file in MS-word that convert existing highlight text to table as 

shown below and save it as file name ‘text_to_table’. Describe all steps 

involved in it. 

Ans: 

o Open the computer. 



o Press the start  icon and go to all application.  

o After that go to MS word a new window with a blank page appear. Move 

the mouse to the location where  want text in the document.  

o Left-click the mouse. The insertion point appears. 

o  Type the text . 

o Select the text that you want to convert in to table. 

o Click insert, table, text convert into table then click on it. 

o Now the  lines automatically change in to table . 

o Click the Microsoft Office button. 

o Select Save As Word Document. The Save As dialog box appears. Select the 

location where  want to save the document using the drop-down.  

o Enter a name for the document as text_to_table . 

o  Click the Save button.   

Q10. Create a file in MS-Word to insert a table in the document. Describe all 

steps involved in it.  

Ans: 

o Open the computer.  

o Press the start  icon and go to all application. 

o  After that go to MS word a new window with a blank page appear. 

Move the mouse to the location where  want text in the document.  

o Left-click the mouse. The insertion point appears.  

o Type the text .Select the text that you want to convert in to table. 

o Click insert,table.Choose a table from it than click on it. 

o Click the Microsoft Office button. 

o Select Save As Word Document. The Save As dialog box appears. 

Select the location where  want to save the document using the 

drop-down.  

o Enter a name for the document . 

o Click the Save button.   

Q11. Create a following worksheet in MS-excel and save it with name ‘book1’. 

 

 

 



 

Ans: 

o Open the computer. 

o Press the start icon and go to all application. 

o After that go to MS- excel and a blank spreadsheet appear. 

o Move the cursor to he column where you want to put your data. 

o Enter your data. 

o Go to file tab. 

o Select save as a dialogue appear. Select the location where you want to 

save the file. 

o Enter the name as book1. 

o Click on save. 

Q12. Calculate the following things of a range (C2:C11) of data in the 

worksheet created in question no 10.  

I. The sum of the marks using AutoSum in a range of cells (C2:C11) 

II. Average of the marks in a range of cells (C2:C11) 

III. Highest marks in a range of cells (C2:C11) 

IV. Minimum marks in a range of cells (C2:C11) 

Ans: 



I. 654 

II. 65.4 

III. 90 

IV. 55 

Q13 a) Describe various steps involved in the following 

 To modify column width of a worksheet 

 To modify the row height of a worksheet 

 To delete rows and columns of a worksheet 

Ans: To modify column width: 

o Position the cursor over the column line in the column heading, and a 

double arrow will appear. 

o  Left-click the mouse, then drag the cursor to the right to increase the 

column width or to the left to decrease the column width. 

o Release the mouse button. 

        To modify the row height: 

o Position the cursor over the row line you want to modify, and a double 

arrow will appear.  

o Left-click the mouse, then drag the cursor upward to decrease the row 

height or downward to increase the row height. 

o Release the mouse button. 

       To delete rows and columns: 

o Select the row or column you’d like to delete. 

o Click the Delete command in the Cells group on the Home tab. 

Q13 b) Describe following terms in the worksheet 

 Absolute reference and relative reference in formula. 

 Cell address 

Ans: Relative reference: All cell references are relative references; when copied 

across multiple cells, they change based on the relative position of rows and 

columns. For example, if you copy the formula =A1+B1 from row 1 to row 2, the 

formula will become =A2+B2. Relative references are especially convenient 

whenever you need to repeat the same calculation across multiple rows or 

columns. 



       Absolute reference: Absolute references do not change when copied or 

filled. You can use an absolute reference to keep a row and/or column constant. 

An absolute reference is designated in a formula by the addition of a dollar sign 

($) before the column and row. 

       Cell address: Its cell has a specific name based on the row or cell where it 

located is known as cell address. 

 Q14. A) What tools are available to customize our PowerPoint presentation? 

Ans: Tools to customize PowerPoint presentation are- 

o Template 

o Front style 

o Colour 

o Pictures etc. 

Q14 b) Write the steps for the following action for creation of power point 

presentation 

 Open a Blank presentation. 

 Save the presentation as Lab1.pptx 

 Add a Title to the first slide: the name of your college 

 Type your first name and last name in the Subtitle section 

 Add a New Slide which has a Title and Content 

Ans: To open a blank presentation 

o Click on start 

o Select MS PowerPoint 

o Double click on it 

o A blank sheet appear 

   To save a presentation 

o Locate and select the Save command on the Quick Access Toolbar. 

o  The Save As pane will appear in backstage view. 

o Then need to choose where to save the file and give it a file name as 

Lab1.pptx. 

o  The Save As dialog box will appear. 

o Click on it . 

    Add a title to the slide 



o Click on the title placeholder. 

o Add the title name as the name of your college. 

o Click on enter. 

Type your first name and last name in the Subtitle section 

o Click on the subtitle place holder . 

o Type your first and the last name on it. 

o Click on enter. 

        Add a New Slide which has a Title and Content 

o Click in the slide where you want to place the object. 

o On the Insert tab, in the Text group, click Object. 

o Click Create from File.  

o In the File box, type the name of the file, or click Browse to select from a 

list. Select the Link check box 

o Press OK. 

Q15. Write steps for creation of a set of PowerPoint slides that 

demonstrates your skill to use the tools of PowerPoint. It should include 

the following things. 

 Title slide &bullet list 

  Inserting Excel Sheet 

  Clip art and Text 

  Slide show effects 

Ans: 

1. Open Microsoft PowerPoint. 

2. Go to File at the top of the screen and click New. 

3. In the “New Presentation” dialog box, click on “From Design Template.” 

(When we start a new presentation PowerPoint, we have the opportunity to 

choose a theme or Template. A theme is a slide design that contains matching 

colors, fonts, and special effects etc.) 

4.Do Slide Design.(As per requirement) … 

5.Adding Text. (As per requirement) 

6.Adding Pictures. . (As per requirement).. 



7.Save the presentation 

Inserting excel sheet: 

I. Select the slide that you want to add a table to. 

II. On the Insert tab, select Table. 

                              PART-2 

Q16. What is the difference between Machine Language and High Level 

Language? 

Ans: Machine Language: A computer programming language consisting of 

binary instructions which a computer can respond to directly. 

 All memory addresses have to be remembered. 

 All operation codes have to be remembered. 

         High -level language: A high-level language is any programming language 

that enables development of a program in a much more user-friendly 

programming context. 

Memory Efficient. 

It is not required to keep track of memory locations. 

Q17. Discuss about different data types of C programming Language. 

Ans: 

Type Keyword Value range which can be represented by this 
data type 

Character char  -128 to 127 or 0 to 255 
Number int  -32,768 to 32,767 or -2,147,483,648 to 

2,147,483,647 
Small number short  -32,768 to 32,767 

Long number long  -2,147,483,648 to 2,147,483,647 
Decimal 
number 

float  1.2E-38 to 3.4E+38 till 6 decimal places 

Q18. Find the output of the following expressions 

a) X=20/5*2+30-5               b) Y=30 – (40/10+6) +10     

c) Z= 40*2/10-2+10 



Ans: a) X=20/5*2+30-5 

               =4*2+30-5 

               =8+30-5 

               = 38-5 

               =33 

        b) Y=30-(40/10+6)+10 

               =30-(4+6)+10 

               =30-10+10 

               =20+10 

               =30 

         c) Z=40*2/10-2+10 

               =80/10-2+10 

               =8-2+10 

               =6+10 

               =16 

 Q19. Describe the syntax of the following statements 

a)If – else statement                          b) for loop                    c) while loop                                        

d) do-while loop   

Ans:  

a) Basic syntax of If-else statement: 

If (expression) 

 { 

 Block of statements; 

 } 

else 

 { 

 Block of statements 



 } 

b) Basic syntax of for loop is as follows: 

 for( expression1; expression2; expression3) 

{ 

Single statement 

or 

Block of statements; 

} 

In the above syntax: 

expression1 - Initializes variables. 

expression2 - Conditional expression, as long as this condition is true, loop will 

keep executing. 

expression3 - expression3 is the modifier which may be simple increment of a 

variable. 

c) Basic syntax of while loop is as follows: 

While ( expression ) 

{ 

 Single statement  

 Or 

 Block of statements; 

} 

d) Basic syntax of do…while loop is as follows: 

Do 

{ 

 Single statement 

 Or 

 Block of statements; 



}while(expression); 

Q20. Find the output of the following program segments 

 

Ans: 

a)IMS Ghaziabad 

b)IMS Ghaziabad 

   IMS Ghaziabad 

c) Largest number is 100 

 

 

 


